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TVP5154EVM User's Guide

Functional Description

The TVP5154EVM evaluation module is a printed circuit board designed for evaluation of the TVP5154
guad video decoder. The board includes the TMS320DM642 digital signal processor (DSP) and is
designed with a 120-pin connector, which allows a connection to multiple backends; the evaluation module
(EVM) is shipped with a professional encoder module. The board is designed to provide ease of use, while
allowing full evaluation of the video decoder.

Description Overview

The TVP5154EVM uses the PC parallel port to emulate the I°C bus, which provides communication with
the TVP5154 video decoder, DM642, and the video encoder. The Windows™ Video Control Center
(WinVCC) application software that communicates with the devices via the 1°C is provided on the EVM
CD-ROM.

The analog video inputs supported by the TVP5154EVM include composite video and S-video. More detalil
about the video inputs is discussed in section 2.3 Video Input Description. In general, the video decoder
converts the analog video input signal into digital component data. This data and the associated clocks
from the video decoder are sent to the DM642, which provides various image capture and display modes.
The DM642 is setup in I1°C slave mode and is controlled through virtual 1°C registers. The video encoder
then converts the digital data from the DM642 back into analog video. The analog video outputs supported
by the EVM include composite video, S-video, and component video. These are all output simultaneously.

To experiment with the programmable features of the TVP5154 video decoder and the video encoder, the
parallel port of the TVP5154 is connected to the parallel port of a PC. WinVCC, a Windows-compatible
application provides the user interface for performing register-level and high-level control of the TVP5154
video decoder and the video encoder.

Code Composer Studio is a trademark of Texas Intruments.
All other trademarks are the property of their respective owners.

6
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Board Level Description
2 Board Level Description

The TVP5154EVM consists of the TVP5154EVM module and the encoder EVM module. A 4-row 120-pin
connector connects the boards. The block diagram of the EVM set is shown in Eigure1l.

av

Flash
Memory

NV -
=
Uyl
Parallel Port
3.3V Reg 3.3V Reg
1.8V Reg 14V Reg
- CVBS
2C Bus s | B 12C Bus
y ¥ v g |z
CH1-CLK-AY g 5 v
———(g Yool | § | € | Yool
TVP5154 ol 5| CF0] | B | & | CF:0] | Video
CH3-CLK-AY |~ DM642 ™ hrideo Clks 2 §- VidEuCIk; Encoder B/Ph
CHICLK-AV_| & s 8 S
£ |z 1
£ E]
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Figure 1. TVP5154EVM Block Diagram

2.1 Test Points and Jumpers

The TVP5154EVM was designed with test points and jumpers to help in evaluation and troubleshooting.
Each jumper is set by default in its preferred state for the TVP5154EVM. There are test points for SCL,

SDA, 3.3V, and 1.8 V. All digital video data for each decoder core are brought out to a dual-row header,
which allows easy hookup to test equipment. The I12C address selection is made with two shunt jumpers,
which are only read after a reset or at power up. The default address is 0xB8. If the address needs to be
changed, the TVP5154 must receive a reset.

Table 1. I°C Address Selection Jumpers
(I2CSEL1, JP9 and I12CSEL2, JP10)

JP9 JP10 I2C ADDRESS
2-3 2-3 0xB8

1-2 2-3 OxBA

2-3 1-2 0xBC

1-0 1-2 OxBE

Table 2. Power-Down-Mode Selection Jumper

(PDN, JP11)

PWDN

1-2

Normal operation

2-3

Power down

SLEUO69A—February 2006 —Revised July 2006
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Board Level Description

2.2

2.3

2.4

Note: If the I2C address is changed on either the TVP5154 board or the encoder board while the
TVP5154EVM is powered up, that device will not recognize the new I12C address. The reset
button on the TVP5154EVM must be pressed and WinVCC must be reconfigured for the new
I2C address.

Common Board Interface

The TVP5154EVM uses a 4-row 120-pin connector to share common signals and the 5-V power supply
between the boards. This connection allows multiple backends to be connected to the TVP5154EVM. The
EVM package is shipped with an encoder module. This connector shares all digital video bits (Y[7:0]), all
video clocks (VS, HS, GLCO/FID, and DATACLK), 5 V, ground, I1°C bus (SCL and SDA), and reset.

Video Input Description

The TVP5154EVM decoder has an analog input channel that accepts two video inputs for each decoder
core. The decoder supports a maximum input voltage range of 0.75 V, therefore, an attenuation of
one-half is needed for most input signals with a peak-to-peak variation of 1.5 V. The parallel termination
before the input to the device is 75 Q. The two analog inputs can be connected as either two selectable
composite video inputs, or one S-video input.

The TVP5154EVM allows the user to have up to two composite inputs or one S-video input for each of the
four-channels. The EVM software sets up and controls this input selection. The S-video input uses two
connectors, one for the luma channel and one for the chroma channel.

The EVM has a resistor network on each of the inputs. These networks attenuate the signal and allow a
75-Q resistor to ground to be placed after the anti-alias filter for termination.

Each input has an anti-alias filter that can be in-circuit or bypassed by jumpers (JP1-JP8). To select the
filter, the shunts need to be positioned to short positions 1-3 and 2-4. To bypass the filter, the shunts need
to be moved to short positions 1-2 and 3-4 as shown in Figure 2. The boards are shipped with the filter
bypassed.

Filter bypassed Filter in circuit

1 0 1
O O

Figure 2. Anti-Aliasing Filter Selection

Video Output Description

The 8-bit digital video outputs of the TVP5154 are routed to the four 32-pin headers (H2-H5), the DM642,
and finally to the 120-pin edge connector along with all video clocks on the TVP5154 module. The
encoder module connects to the 120-pin connector, and is capable of receiving digital video with or
without embedded syncs. The analog outputs of the encoder module are composite, S-video, and
component. For the user’s convenience, all of these outputs come out of the encoder module
simultaneously.

TVP5154EVM User's Guide SLEUO69A—February 2006—Revised July 2006
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System-Level Description

3 System-Level Description
A system-level block diagram incorporating the TVP5154 is shown in Figure 3. Typical
commercially-available test equipment is also shown. The primary features of this configuration are:

» Power is provided by a single 5-V power supply provided with the EVM and is shared between both
modules via the 120-pin connector.

» Supported analog inputs include composite video and S-video.

» Re-encoded composite video and S-video are output via the encoder module.

» Component (YPDbPr) video is output via the encoder module.

« I2C bus initializes the video devices via a PC parallel port.

» The TVP5154 video decoder performance parameters may be measured with a video analyzer.

Computer Power
Camera ! Supply
Yideo
Source l l
Camera/f Composite Composite
Video > »  Tektronix
Source | * TVP5154 Video S¥ideo | NTSCIPAL V\TZOOT
.| DM842 —» Encoder 7 Monitor M ldeo ¢
Camera/ J . Module Module Component easg:.:men
Video 7
Source TVP5154EVIM
Camera/
Yideo
Source

Figure 3. TVP5154EVM System-Level Block Diagram

4 Required Hardware and Equipment

The required hardware and equipment necessary to use the TVP5154EVM are:

* TVP5154EVM (provided)

» Universal 5-V power supply (provided)

» Parallel cable (provided)

* Windows-based PC with CD-ROM drive and Win95™ or later

» Composite or S-video cables for inputs

» Composite, S-video, or component cable for output

» Video sources (security camera, pattern generator, Quantum generator, DVD player, etc.)
» Display monitor that supports composite, S-video, or component video input

5 Hardware Setup

shows the TVP5154EVM layout and indicates the location of the power supply and the
appropriate connectors. All connectors are labeled according to their function. To prepare the EVM for
evaluation, connect the following:

TVP5154 module to encoder module

Parallel port cable from TVP5154EVM to the PC

Analog video sources to TVP5154EVM inputs

Analog video out from TVP5154EVM to monitor

5-V power supply to the dc jack on the TVP5154 board. A green LED on each board should now be lit.

akrwpne
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Software Installation

The system comes with the anti-alias filters bypassed. To connect the filters, you must rotate the
appropriate jumpers (JP1-JP8) as described in section 2.3.

The I°C slave address can be selected with jumpers JP9 and JP10. There are four possible addresses:
B8, BA, BC, and BE. The default setting for these jumpers is for the shunt to short pins 2-3, which selects
0xB8. These are connected to pins 117 and 118, which are read at power up. If you move both the
jumpers to positions 1-2 and reset the board, the video decoder now responds to I1°C slave address OxBE.
If you choose to change the address, you must exit, restart WinVCC, and configure the software to use
the new I2C slave address.

6 Software Installation

WinVCC is a Windows application that uses the PC parallel port to emulate 1°C, providing access to each
device on the I1°C bus. WinVCC makes use of CMD files, a text editable file that allows preset video
setups to be programmed easily.

This feature allows the user to easily set multiple I°C registers with the press of a button. WinVCC also
has property sheets for the TVP5154, which allows the user to control the I12C registers with a GUI.

All necessary software for the TVP5154EVM is provided on the enclosed CD. Perform the following steps
to install WinVCC:
1. Explore the provided TVP5154EVM Software CD.

2. Install Port95NT.exe. This is the parallel port driver used by WinVCC. This driver must be installed and
the PC must be rebooted before WinVVCC operates correctly. This does not affect normal parallel port
operation.

3. Install Setup.exe. Click Next at all prompts and click Finish to complete the installation process. This
installs WinVCC onto the PC. No reboot is required.

4. Run WinVCC.exe.

Note: A shortcut to WinVCC should now be available on the desktop. WinVCC and additional
TVP5154-related documentation can also be found at Start - Programs - TVP5154EVM
Software.

7 WinVCC Quick Start

Perform the following steps in order to see a video output from the TVP5154EVM.

1. Once WinVCC is executed, the WinVCC Configuration screen appears, as shown in Eigure 4. This
dialog box configures the I1°C bus. Next to VID_DEC, select the TVP5154 and ensure the 1°C address
is set to 0xB8 (default setting on EVM.) This must match the I°C ADDR jumper on the TVP5154 board.

2. Nextto VID_ENC, select the 7311 Encoder and ensure the 1°C address is set to 0x54 (default setting
on EVM.) This must match the 1°C ADDR jumper on the encoder board.

Note: If WinVCC is running and the TVP5154 or encoder board I2C address is changed, power
must be cycled on the EVM.

10 TVP5154EVM User's Guide SLEUO69A—February 2006—Revised July 2006
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WinVCC Quick Start

Win¥CC Configuration

[2C5vSTEM CONFIGURATION

DEYICE FAMILY SPECIFIC DEVICE [2C BUS MASTER
T¥P3000 |NOT USED |
[AudioAideo Proceszar)
T*F3300 WOT USED -
[Qak ASE Receiver) | J | J
viD_DEC [ DVE [[DESE | |
[idea Decader)
VID_ENC | 7311 Encoder = | |
[*iden Encoder)
™VE7O0O [ DVE |N|:|T LSED j | J
[Video/Graphiczs Digitizer)
THS8200 [NOT USED =l =

[HDTWASDTV/RGE DALC)

PROGRAM OFPTIOMS
EMABLE | I2C System Test [after clcking OF)

EMABLE | I2C Acknowledge Checking

Auto-Update from Device [when activating a
EMABLE - ?
window or tabbing bebween property pages)

4

0k, Ewit Pragran

|2C SLAVE ADDR

12C Slave Addr

0

1

Egh

Bah

BCh

Sdh

Bah

40k

" Bah

" Bah
" BEh
" BEh

" Bah

v 42h

Figure 4. WinVCC — I°C Configuration Screen

3. Ensure that all other boxes are selected as “Not Used” and that all program options buttons are set to

ENABLE. Click OK.

4. If there are no 1°C communication issues, the Real-Time Polling dialog window displays next as shown
in Figure 3. If there are 1°C issues, an I1°C Test Report box displays. Completely exit out of WinVCC,
double-check the parallel port cable connections, I°C address settings, cycle power on the

TVP5154EVM, and re-run WinVCC.

5. When using the TVP5154 EVM with a composite output from the 7311 encoder, it is required to disable
auto-switch polling in the Real-Time Polling dialog box by clicking on the ENABLED button. Click OK

and then the Main Control Window is seen, as shown in Eigure 7.

SLEUO69A—February 2006 —Revised July 2006
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WinVCC Quick Start

Real-Time Polling

Click to Enable or Disable

EMAELED YIDED-STANDARD AUTO-SWITCH POLLIMNG
[Palls TWPE:4 far a video standard switch and updates the video output device].

LINE COUNT CORRECTION POLLING
[Palls for changes in TYPS<4 line count and updates the video output device].

DisabIeAII| oK | Enable 4l |

Figure 5. Real-Time Polling Dialog

6. The TVP5154 I>C Write Enable(s) and Read Enable pop-up window is displayed as shown in Figure 4.

This is used to select which decoder or decoders (any combination of all four) will receive 12C Write
commands, and which decoder (only one) will receive I°C Read commands. Decoder 1 is Enabled by
default; enable the other three decoders by clicking on each decoder’s enable button.

TWP5E154 [2C Wiite Enable(s] TWF5154 |2C Read Enable
Decoder 1 Decoder 2 Decoder3  Decoder 4 * Decoder1 " Decoder?

Enabled | Disabled | Disabled | Disabled | |~ p_oider3 © Deooderd

Figure 6. Decoder I12C Write and Read Enable

Load the provided Initialization command (CMD) file into WinVCC by clicking on Tools - System
Initialization - Browse. The default directory is C:\Program Files\Texas
Instruments\TVP5154EVM\Initialization.

"2 Windows ¥ideo Control Center

File Edit Tools ‘Window Help

Figure 7. WinVCC — Main Screen

. In the System Initialization Window (see Figure g), click the “TVP5154 ROM - Initialize for NTSC..."” or
“TVP5154 ROM - Initialize for PAL...” dataset in the window and then click the PROGRAM Device(s)
Using Selected Dataset button to initialize the TVP5154EVM.

TVP5154EVM User's Guide SLEUO69A—February 2006—Revised July 2006
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System Initialization

Command File |C:%\Program FileshTexas Instrumentsh TWPS1 54EV M nitialization, TYPE1 54 ROM + DME42 + 7311 Encoder.crd Browse...

Cornmand File Operations Bytes Per Block

= Al Reload
REPLACE APPEND PROGRAM Wt e
Selected Dataset Current Drevicels) i =
with Current Device Settings Using Werify...
Device Settings to CMD File Selected Dataset Status
| Ready Close

Datazet Descriptions

TWP5154 BOM - Initialize for NTSC - Decoders in default mode + DME42 Enabled + & 11 setup - MUST DISABLE POLLING ~
TYP5154 ROM - Initialize for PaL - Decoders in default mode + DME42 Enabled + A0%7311 setup - MUST DISABLE POLLING

1
2
3
4 =TWP5154 NT5C Scaler Example - Enabled Decoder(s] Scaled from MTSC [720=480] to SIF [3524240). default DME42 quad pasition

5 =TVP3154 NTSC Scaler Example - Enabled Decoder(s] Scaled from NTSC [F20:480] to QSIF [176x120], default DME42 quad position
E = TVPA184 NTSC Scaler Erample - Decoder 1=051F, Quad 1; 2=05IF, Quad 3; 3=0%GA, Ouad 3; 4=unzcaled, Quad 1

8 =TVP3154 PAL Scaler Example - Enabled Decoder(z] Scaled from PAL [720x576] to CIF [3524288), default DME42 quad position
9=TVP5154 PAL Scaler Example - Enabled Decoder(z] Scaled from PAL [720x576] to QCIF [176x144), default DME42 quad position
10 = TVP5154 PAL Scaler Example - Decoder 1=0CIF, Quad 1; 2=0CIF, Quad 3; 3=0VG4, Quad 3; 4=unscaled, Quad 1

1=

12 = TYP5154 - Decoder 1 = unscaled full screen
13 = TVP5154 - Decoder 2 = unscaled full screen
14 = TWP5154 - Decader 3 = unscaled full screen
1R = TWPRIRA - Mernder 4 = nrsraled ioll seresn

; Decoders 2.3.4 disabled
: Decoders 1.3.4 dizabled
: Decoders 1.2.4 disabled
- MNerndars 12 3 disahblad

8.1

MOTES:
1. To access the factory-supplied initialization files, browse to: ¢:\Program FileshT exas [nstruments\WWinWCCAATYPE1 544 nitialization'”. cmd

2. IF REPLACE or APPEMD functions will be used, click RELOAD whenever the video decoder EVM is reset or power-cycled.

Figure 8. WinVCC - System Initialization

9. With video sources provided at the BNC connectors and the EVM output connected to a monitor, video
from the source connected to CH1 should be viewable on the display monitor.

10. The other datasets in the command file are provided to demonstrate examples of 5154 scaling
performance. Refer to the TVP5154 data sheet (SLES163) or Scaler application report for more details
on programming the TVP5154 scaler. The DM642 settings can be controlled by using the DM642
Control Window, which is found by clicking on Tools -~ DM642 Control. Refer to Chapter 9 for details on
programming the DM642 through this window or through the Generic I°C registers.

WinVCC in Depth

The following sections describe how to use Windows™ Video Control Center (WinVCC) in depth. It
discusses various features and screens that the user may encounter while evaluating the TVP5154EVM.

Starting WinVCC

The Port95NT parallel port driver must be installed before using WinVCC. WinVCC may be started by
clicking on Start - All Programs - TVP5154EVM Software - WinVCC.

If the dialog box shown in is displayed, it means one of two things:

WinVCC did not run to completion the last time it ran. In this case, click OK to exit the program and
restart WinvVCC.

» There is more than one instance of WinVCC running at the same time. In this case, click OK to exit the
program. Then, press CTRL-ALT-DELETE to bring up the Task Manager. Select and click End Task
on all occurrences of WinVCC or WinVCC CONFIGURATION. Then restart WinVCC.

IF the previous run of WinYCC was terminated abnormally, click OK and start WinyCC again, Otherwise, more than one instance of WinWCC may be running! Click Ok
to close this program. Then, press Ctl-alt-Delete, Highlight and click "End Task" to terminate all instances of wWindows Yideo Control Center (or WINYCC

A

Configuration).

Figure 9. WinVCC Multiple Occurrences Error Message
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8.2 WinVCC Configuration Dialog Box
The WinVCC Configuration dialog box (see Figure 10) should now be visible. This dialog box configures
the 1°C bus on the TVP5154EVM. All settings from this dialog box are stored in the Windows registry and
are restored the next time the program is started. After initial installation, VID_DEC is set to TVP5154 and
VID_ENC is set to 7311 Encoder.
The I°C slave address for each device must match the 1°C slave address selected by jumpers on the
TVP5154EVM. These jumpers are set by the factory to use 0xB8 for the TVP5154 and 0x54 for the
Encoder. It is also important to select the correct Specific Device type for the video decoder. TVP5154 and
7311 Encoder must be selected for this EVM.
All Program Options must be enabled. Disabling these options is only required if debugging a problem
with the I1°C bus.
Clicking OK begins I2C communication with the selected devices.
Win¥CC Configuration
[2C SYSTEM CONFIGURATION
DEVICE FamILY SPECIFIC DEWICE [2CBUS MASTER |2C SLAVE ADDR
T¥P3000 |NOT USED |
[AudioAideo Proceszar) |20 Slave Addr
TVFI300 NOT USED - o r
[Qak ASE Receiver) | J | J BEh B
viD_DEC ™ DVvE (DS | ~| | & Banh ¢ Bah
[Video Decoder) ~ BCh  BEHR
VID_ENC | 7311 Encoder = | | | @& 540 € 5eh
[*iden Encoder)
VP70 T DVE [noT USED - & Beh ¢ BAR
[Video/Graphiczs Digitizer) | J | J
THS8200 |NOT USED ~| | | T 40k & 4zh
(HOTVADTV/RGE DAC)
PROGRAM OPTIONS
EMABLE | I2C System Test [after clcking OF)
EMABLE | I2C Acknowledge Checking
ENAELE Auto-Update from Device [when activating a
window or tabbing bebween property pages)
0k, Ewit Pragran
Figure 10. WinVCC I°C Address Configuration
8.3 I°C System Test
The I°C system test of selected registers runs immediately after closing the WinVCC Configuration dialog
box with OK (unless the 1°C system test program options button was disabled).
If the 1°C system test passes, only a PASS message appears. If the test failed, a dialog box like the one
shown in appears. See Section 10, Troubleshooting, for details on how to resolve this issue.
14 TVP5154EVM User's Guide SLEUO69A—February 2006—Revised July 2006
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8.4

The I2C system test can be run at anytime by clicking Run System I°C Test in the Tools menu.

I12C Test Report

TWPE154. FAILED - Read, Dev=0xB2, Addr=0xD0, Data=0x78 - Mizcompare wiate 0=00)

#3117 Encoder Module.. MOT TESTED

Figure 11. I°C System Failure

Real-Time Polling

Real-time polling provides polling functions that execute continuously in the background, when enabled via
the Real-Time Polling dialog. There are two polling functions. The function that applies to the TVP5154 is
VIDEO-STANDARD AUTO-SWITCH POLLING.

When the TVP5154 detects a change in the input video standard, it automatically switches to operation in
the detected standard (which includes all necessary I°C register initialization) for proper decoding of the
input video. To enable auto-switch on the TVP5154, the Set Video Standard register must be set to
auto-switch mode (Reg 0x28 = 0x00).

If the WinVCC auto-switch polling function is enabled, the detected video standard status from the
TVP5154 is polled until a change in the input video standard (or in the TVP5154 sampling mode) is
detected. When a change is detected, the video encoder is reprogrammed as needed for the detected
standard. Using this feature, the video source can change its video standard and the system displays
using the new standard, without user intervention.

When using the TVP5154 EVM with the DM642 and a composite output from the 7311 encoder, it is
required to disable auto-switch polling by clicking on the ENABLED button in the Real-Time Polling dialog

box as shown in Eigure 12.

The real-time polling dialog can also be accessed once WinVCC is up and running by clicking Real-Time
Polling in the Tools menu.
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Real-Time Polling

Click to Enable or Dizable

ENAELED YIDEQ-STAMDARD AUTO-5WITCH POLLING
[Polls TYPES4 for a video standard switch and updates the video output device).

LINE COUNT CORRECTION POLLING
[Pallz far changes in TWPS line count and updates the video output device).

Disable Al | aK. | Enable &l |

Figure 12. Real-Time Polling Dialog

8.5 Main Menu

After closing the real-time polling dialog, the main menu is displayed as shown in Figure 13. The menus,
which are used to operate WinVCC, are File, Edit, Tools, Window, and Help. The File menu’s only function
is Exit, which terminates the program. summarizes the main menu contents.

*? Windows Yideo Control Center [ZI[EI[‘S_TI
File Edit Tools ‘Window Help

Figure 13. WinVCC — Main Screen

Table 3. Main Menu Summary

MENU CONTENTS
File Exit
Edit Register Map
TVP5154
7311 Encoder Module
Generic 12C
Memory Map
TVP5154

7311 Encoder Module
Property Sheets

TVP5154

7311 Encoder Module

Tools System lInitialization

Real-time Polling

TV Tuner Control (FQ12xx series only)
Multiple-Byte 12C Transfers

Set I2C Bit Rate

Run System I2C Test

Run Continuous 12C Test

Read VBI FIFO

Capture Live VBI Data

DM642 Control

Window | Allows selection of the active window. Multiple windows can be open at the same time.

Help Displays program version
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The TVP5154 I12C Write Enable(s) and Read Enable pop-up window is displayed as shown in Figure 14.
This is used to select which decoder or decoders (any combination of all four) will receive 12C Write
commands, and which decoder (only one) will receive I°C Read commands. Decoder 1 is Enabled by
default; enable the other three decoders by clicking on each decoder’s enable button.

TWP5E154 [2C Wiite Enable(s] TWF5154 |2C Read Enable
Decoder 1 Decoder 2 Decoder3  Decoder 4 * Decoder1 " Decoder?

Enabled | Disabled | Disabled | Disabled | |~ p_oider3 © Deooderd

Figure 14. Decoder I°C Write and Read Enable

8.5.1 System Initialization

Clicking System Initialization in the Tools menu displays the dialog box shown in Figure 15. This dialog
box provides the means for initializing the TVP5154 decoder(s) and/or video encoder for a particular video
mode, as well as programming settings for the DM642 through the Generic I°C registers. The details of
the initialization are contained in the command file (with a CMD file extension).

The command file is loaded using the Browse... button. Once the command file is opened, a text list
displays descriptions of the individual datasets contained within the command file.

Click once on the desired dataset description to select it. Click the Program Device(s) Using Selected
Dataset button to run the selected dataset, which loads the devices via the 1°C bus. When the device
initialization has completed, the status indicator reads Ready.

Note: If Ready does not display, the devices are not initialized and the 12C bus is not
communicating. See Chapter 10, Troubleshooting, for possible solutions.

Click the OK button to close the dialog box. Each time the System Initialization dialog box is closed, the
initialization file pathname and the dataset selection number are saved in the Windows registry to allow
these settings to be retained for the next time WinVCC runs.
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System Initialization

Command File |C:%Program FileshTexas Instumentsh TVYPS154EV M nitialization . TVF5154 ROM + DME42 + 7311 Encoder.cmd Browse. .

Command File Operations Biptes Per Black e
=l eloa
REPLACE APPEND PROGRAM sl
Selected D ataset Current Device(s) 0 ;
with Current Device Setings I sirg Werfy...
Device Settings to CkD File Selected Dataset Status

| Ready Close

ddild

Datazet Descriptions

in default mode + DME42 Enabled + ADY
default mode + DME4Z Enabled + A0W7Y.

1 = TWF5154 ROM - |nitial
2= TWPE154 ROM - Initia
3

4 = TWP5154 NTSC Scaler Example - Enabled Decader(z] Scaled from MTSC [720x480) to SIF [352x240], default DME42 quad position
5=TWPE154 NTSC Scaler Example - Enabled Decoder(s] Scaled from MTSC [720x480) to QS5IF [176+120). default DME42 quad position
G = TWP5154 NT5C Scaler Example - Decoder 1=05IF, Quad 1; 2=05IF. Quad 3; 3=0%GA. Quad 3; d=unscaled. Quad 1

7=

8 = TWPH154 PaL Scaler Example - Enabled Decoder(s) Scaled from PAL [720x576) to CIF [352288), default DME42 quad position

9= TWP5154 PAL Scaler Example - Enabled Decoder(z) Scaled from PAL [720x576) to QCIF [176x144), default DMEAZ quad position

10 = TWP5154 PAL Scaler Example - Decoder 1=0CIF, Quad 1; 2=0CIF, Quad 3; 3=0VGA, Quad 3; 4=unscaled, Quad 1

1=

12 = TWP5154 - Decoder 1 = unzcaled full screen; Decoders 2,3.4 dizabled

13 =TWFA154 - Decoder 2 = unzcaled full screen; Decoders 1,3.4 dizabled

14 = TWFA154 - Decoder 3 = unzcaled full zoreen; Decoders 1,2.4 dizabled 7
1R = TWPR1FRA - Merader 4 = nnscaled Bl 2ereens Necaders 1 23 dizahbled

MNOTES:
1. To access the Factory-supplied initialization files, browse to: c:\Program FileshT eras Instruments WinCC4ATWPE1 SdM nitialization'*. cmd

2 If REPLACE or APPEMD functions will be used, click RELOAD whenewer the video decoder EVM iz rezet or power-cycled.

Figure 15. System Initialization

8.5.1.1 Adding a Custom Dataset
After programming the EVM via the System Initialization tool using the factory-supplied command file, you
can customize the device register settings to fit your needs. Perform the following steps to save your
custom settings:
1. Reopen the System Initialization dialog box via the Tools menu.
2. Click the Append Current Device Settings to Command File button. A dialog box requesting a
description of the new dataset appears.
Optionally, click the drop-down box and select one of the existing descriptions.
Modify the description text or type your own description.
5. Click OK. All nondefault register values from the TVP5154, DM642, and encoder are appended to the
current command file as an additional dataset.

Now, you can select your custom dataset and send it with a press of the Program... button.

By using the same procedure above with the Replace Selected Dataset with Current Device Settings
button you can overwrite an existing dataset with the current settings.

P w

Note: If editing the command file (.CMD) using a standard editor, the file must be saved as plain
text.

SLEUO69A—February 2006—Revised July 2006
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8.5.1.2 Command Files

The command file is a text file that can be generated using any common editor; however, it must be saved
as plain text. Command files are especially useful for quickly switching between the various system
configurations. These .CMD files are unrelated to the typical Windows .CMD files.

A default command file is provided on the CD. This command file contains many examples of the desired
setups. This command file is located at:

c:\Program Files\Texas Instruments\TVP5154EVM\Initialization\

A command file can contain up to 250 datasets. A dataset is a set of register settings to initialize the
TVP5154 decoder, 7311 encoder, and/or DM642 for a particular video mode. Each dataset includes a
description that is displayed in one row of the dataset descriptions list. The register settings may be
located in the command file itself and/or may be stored in separate include file(s) (with an .INC file
extension) and be included into the command file using the INCLUDE statement.

8.5.1.3 Example Command File

An example of one dataset within a command file is shown below.
BEG N_DATASET

DATASET_NAME, " TVP5154, Aut o-switch, Stable Sync, Fast-Ilock, 656 Cut”
/1 Initialize video encoder using an include file

I NCLUDE, Encoder NTSC656_RTC. | NC

/1 Program TVP5154 registers

WR_REG VI D _DEC, 1, 0x7F, 0x00 // Reset 5154 m croprocessor

WR_REG VI D_DEC, 1, 0x03, 0xOD // Enabl e YCbCr outputs and syncs

WR_REG VI D_DEC, 1, 0x15, 0x81 // Enabl e Stable Sync node

WR_REG VI D_DEC, 1, 0x02, 0x80 // Enabl e Fast-Iock node

END_DATASET

Each command file may contain individual write-to-register (WR_REG) commands.
» The comment indicator is the double-slash //.

» The command file is not case sensitive and ignores all white-space characters.
» All numbers can be entered as hexadecimal (beginning with 0x) or as decimal.

» Every dataset in a command file begins with BEGIN_DATASET and ends with END_DATASET. The
maximum number of datasets is 250.

» The dataset text description is entered between double quotes using the DATASET NAME command.
The enclosed text can be up to 128 characters in length. This text appears in the System Initialization
dialog box when the command file is opened.

* The INCLUDE command inserts the contents of an include file (with an .INC file extension) in-line in

place of the INCLUDE command. Therefore, the include file must not contain the BEGIN_DATASET,
END_DATASET, and DATASET_NAME commands.

Note: Allincluded files must be located in the same directory as the command (CMD) file.

* The write-to-register command is written as:

WR_REG, <DeviceFamily>, <Number of data bytes (N)>, <subaddress>, <Datal>,..., <DataN>
or
WR_REG, <Literal slave address>, <Number of data bytes (N)>, <subaddress>, <Datal>,..., <DataN>

The valid device family mnemonics are:
VID_DEC for the video decoders
VID_ENC for the video encoders
THS8200 for the THS8200 device

WinVCC translates the device family mnemonic to the slave address that was selected in the WinVCC
Configuration dialog box upon program startup. This eliminates having to edit command files if the
alternate slave address must be used.
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If the literal slave address method is used, the slave address entered is used directly. This method is
normally used for programming the video encoder.
The slave address 0x40h is used to access the DM642.
» A delay may be inserted between commands using the WAIT command, which is written as:
WAIT,<# milliseconds>

8.5.2 Register Editing

The next section describes the five available modes of register editing: TVP5154 Register Map editor,
7311 Encoder Module Register Map editor, Generic I°C Register Map editor, TVP5154 memory map
editor, and TVP5154 Property Sheets. Each of these functions can be selected from the Edit menu.

8.5.2.1 Register Map Editor

The TVP5154 Register Map editor (see allows the display and editing of the entire used
register space of the device within a simple scrolling text box. To open this, click on Edit Register Map in
the Edit menu and click on the device type to edit. describes how to use each of the controls in
the TVP5154 Register Map editor.

T¥P5154 (0xB8) Register, Map

Address | Data | R | M ame | Description | ~
oo oo Raw Video Input Source Select 1

01 15 RM Analog Channel Controls

02 a0 S Operation Mode Controls

03 0| RAy Misc. Contral:

04 5] e R Auto-Switch Standard bask-OFf

05 uli} R Clock Control

0e 1o R/ Color Killer Chrls

o7 B0 RM Luminance Proceszing Chil 1

0g i} RAy Luminance Processing Chl 2 B

MOTE 1: &ny address not shown in the list can be accessed by tuping the address and then clicking Read o “Wite,

Loop Count -
Address Wit ’% Applies to \Write fladi
E dit Indirect Registers ’E =T ﬁ and Fead buttons. Dec
=1 1-999) Hex 67
Read Histogram on Loop Count Reads
Data AND [FF =
lﬁj Read Al [~ Enable Ve ’_ ow M

Figure 16. TVP5154 Register Map Editor

20 TVP5154EVM User's Guide SLEUO69A—February 2006—Revised July 2006
[Eubmit Documentafion FeedbacH



http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLEU069A

{'f TEXAS
INSTRUMENTS

www.ti.com

WinVCC in Depth

Table 4. TVP5154 Register Map Editor Controls

CONTROL DEFINITION
Register Window | Scrolling text box that displays the address and data for the I12C registers that are defined for the device

Contains the 12C subaddress that will be accessed using the Write and Read buttons. Clicking on a row selects

Address Edit Box an address, which then appears in the address edit box.

NOTE: After clicking on a row, the Data Edit box contains the data that was in the register window. The device
has not yet been read.

The address up/down arrows are used to jump to the next/previous subaddress that is defined for the device. If
an address is not defined for the device, it can still be accessed by typing the subaddress in the Address Edit
box.

Data Edit Box Contains the data which will be written to, or was read from, the 12C subaddress.

The data up/down arrows increment/decrement the data value by 1.

Write Button Writes the byte in the Data Edit box to the address in the Address Edit box.

The I2C register is written to whether or not the data is different from the last time the register was read.

Read Button Reads the data from the address in the Address Edit box into the Data Edit box and the register window.

Read All Button Reads all defined readable registers from the device and updates the register window.

Hex Button Converts all values in the register window and address and data edit boxes to hexadecimal.
Dec Button Converts all values in the register window and address and data edit boxes to decimal.
Close Button Closes the dialog.

NOTE: Multiple edit register map windows can be open at the same time (one for each device). Use the
Window menu to navigate.

Causes subsequent write, read, or read all operations to be performed N times. N is entered as a decimal

Loop Count number from 1 to 999.

8.5.2.2 Encoder Module Register Map Editor

The Encoder Module Register Map editor (see Figure 17) allows the display and editing of the video
encoder registers. This editor works like the TVP5154 Register Map editor.

To open this, click on Register Map in the Edit menu and click on 7311 Encoder Module.

7311 Encoder, Module {0x54) Register Map

Addressl Data | R | Mame | Diescription | ~
oo FC R Power Maode Register

01 38 R Mode Select Register

02 20 S Mode Register 0

03 03 RAw FAGE Matiz 0

04 FO R&w RGE Matix 1

05 4E R&w FAGE Matix 2

06 0E RAw FAGE Matix 3

o7 24 RAw RGE Matix 4

03 32 R#w RAGE Matix 5 %

MOTE 1: Anw address not shown in the list can be accessed by typing the address and then clicking Read o ‘Wiite,

Loop Count -
Address Wit ’17 Applies to 'Writs fladt
=T] and Read buttons. Dec
=1 i-999) Hex &
Read Histagram on Loop Count Reads

Data AND

= BT (R a
[ = Fead Al Mask J Close

Figure 17. 7311 Encoder Module Register Map Editor

8.5.2.3  Generic I°C Register Editor

The Generic I1°C Register editor (see allows the display and editing of any device on the I°C
bus. This editor works like the TVP5154 Register Map editor, except that the I°C slave address must be
entered and the Read All button is disabled.

To open this, click on Register Map in the Edit menu and then click on Generic I1°C.
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The DM642 I2C registers can be edited using I°C sub-address 0x40. See for details about the

DM642 registers.

The video encoder module registers can be edited using I1°C sub-address 0x54 (default) or 0x56 if the

alternate slave address is being used.

Generic [2C Register, Map

| Description | ~

Address .
W =] Wfrite
=

Data

Address| Data | R | M armne
12 R
nz 2 R
03 32 R
n4 m R
1] m R At
0g m R
o7 o R
ns oo R
|2C Slave

Address

K

[ Use Repeated Start Laap Gt

1
[1-933)

Read Histogram on Loop Count Reads [or Read Alls)

-

Loop Count Radi
Applies towiite, A
Read and Read Al Dec O
Hex *

’E ﬂ [ Enable

FF M Cloze

Figure 18. Generic I1°C Register Map Editor

8.5.24  Memory Map Editor
The memory map editor (see allows the display and editing of the data memory and hardware

registers of the device, such as the scaler setting registers.

To open this, click on Memory Map in the Edit menu and click on the device type to edit. The operation of

the memory map editor controls are explained in [[able 5.

TYP5154 (0xB8) Edit Memory

Addrezsz Range

\HAW Fregisters: 300 - 3FF

A00OR
OFFSET

]

EENEE

LSEB

Higtogram on Loop Count Reads

AN
[ Enable Mk FFFFFFFF Show

NOTES:

= Loop count applies to both read and wiite buttonz.

LOOP COUMT
1 Fead | Write Cloze |
[1-939)]

Figure 19. Memory Map Editor
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Table 5. Memory Map Editor Controls
CONTROL DEFINITION

Base Address Selector The hardware registers use a 10-bit address internally. The base address selector allows quick entry
of the base address. The list contains base addresses for the major functional blocks of the
TVP5154.

Address Offset Edit Box Contains the lowest byte of the 10-bit internal address. The full 10-bit address is formed by adding
the base address to the address offset. The address up/down arrows increment/decrement the
address offset by 1.

Data Edit Boxes Contains the 16-bit data word that is written to or read from the register address. The LSB data is at
the lowest address. The data is written/read LSB first. The data up/down arrows
increment/decrement the data value by 1.

Write Button Writes the (2) bytes in the data edit boxes starting at the 10-bit register address BASE+OFFSET.

Read Button Reads (2) consecutive data bytes starting at the 10-bit register address BASE+OFFSET to the data
edit boxes.

Loop Count Edit Box Causes subsequent write or read operations to be performed N times. N is entered as a decimal
number from 1 to 999.

Histogram on Creates a histogram of the results from the Loop Count Reads.

Loop Count Reads

Close Button Closes the dialog.

Note: The memory map editor can remain open with other
windows. Use the Window menu to navigate.

8.6 TVP5154 Property Sheets

The property sheets represent the register data in a user-friendly format. The data is organized by
function, with each function having its own page and being selectable via tabs at the top (see Eigure 20).

To open this, click on Edit Property Sheets in the Edit menu and select the device type to edit.

When the property sheet function is started or whenever the user tabs to a different page, all readable
registers in the device are read from hardware to initialize the dialog pages. Values on the page are
changed by manipulating the various dialog controls as described in [Table §.

OK, Cancel, and Apply buttons are at the bottom of each property page. These are described in [Table 7.
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8.6.1

TVP5154 (0xB8) Property Sheets

Yideo Decoder Status I Scaler

Widzo Auto-Switch Mask

r Auto-Switch Status
r ENABLED

I [M]PAL

W [Ne) PAL

¥ NTSE 443 [ Video Input has Blanking Pedestal

| SR Check all video standards to be EXCLUDED

from auto-switch processing.

Detected Yideo Standard

[MNTSC Fead Al

tode Selection I Analog Video ] Automatic: G ain Control ] Chroma Data Path ] Lumna D ata Path ] Spnchranization ] Output Contral I M acrovision Detection ]

BT.656 Contrals |

0K | Cancel ‘ Apply |

Figure 20. TVP5154 Property Sheets

Property Sheet Refresh

The property sheets are designed so that the data displayed is always current. Certain actions cause the
entire register map to be read from the device and to update the property sheets. This happens when:

8.6.1.1

Property sheets are initially opened.
When tabbing from one page to another.
When Read All is clicked.

When making the TVP5154 Property Sheets window the active window (by clicking on it).
When making a TVP5154 Register Map editor window the active window (by clicking on it).

Auto-Update From Device

The last two items in the Property Sheet Refresh list (see section 8.6.1) are referred to as the
Auto-Update feature. Auto-Update can be disabled by setting its program option button to DISABLED.

This button is located on the initial dialog box (WinVCC Configuration).

With Auto-Update enabled (default), the user can open both the TVP5154 Property Sheets and the
TVP5154 Register Map editor at the same time. Changes made to the property sheets (and applied) are
updated in the register map window as soon as the Register Map window is clicked on. Additionally,
changes made in the TVP5154 Register Map editor are updated in the TVP5154 Property Sheets as soon
as the property sheets window is clicked on.
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Table 6. Use of Property Sheet Controls

PROPERTY SHEETS

DIALOG CONTROL

WHAT DO | DO WITH IT?

When is Hardware Updated?

Read-Only Edit Box Read status information N/A

Check Box Toggle a single bit After Apply
Drop-Down List Select from a text list After Apply
Edit Box Type a number After Apply

Edit Box with Up/Down arrows

Use up/down arrows or type a number

Up/Down arrows: Immediately
Type a number: After Apply

9.1

Slider Slide a lever Immediately
Pushbutton Initiate an action Immediately
Table 7. Property Sheet Button Controls
BUTTON
CONTROL DEFINITION

OK Writes to all writeable registers whose data has changed. A register is flagged as changed if the value to be
written is different from the value last read from that address.
Closes the dialog.

Cancel Causes all changes made to the property page since the last Apply to be discarded. Changes made to dialog
controls with ‘immediate hardware update’ are not discarded, since they have already been changed in
hardware.

Does not write to hardware.
Closes the dialog.

Apply Writes to all writeable registers whose data has changed. A register is flagged as changed if the value to be

written is different from the value last read from that address.

Programming the TMS320DM642

This chapter discusses how to change settings for the TMS320DM642 on this EVM. The DM642 settings
can be controlled by using the DM642 Control Window, which is found by clicking on Tools - DM642
Control, or through the Generic I1°C registers.

Development and Purpose of DM642 Code

The TVP5154EVM was developed by the Tl Digital Video Department, which is responsible for the
TVP5146 and TVP5150AM1 video decoders currently used on the DM642EVM released by Spectrum
Digital. The TVP5154EVM hardware and software are both based on this DM642EVM.

The TVP5154EVM was designed specifically for security customers interested in a quad video decoder.
The TVP5154EVM showcases the TVP5154 with various scaled/unscaled display modes, while making
the DM642 transparent to the customer during evaluation. This is made possible by placing the DM642
into an I1°C slave mode and controlling the capture/display modes using virtual I°C registers. The entire
TVP5154EVM is controlled by a PC emulating I°C via the parallel port. By downloading the DM642 code
from flash at power up, it is not required to use Code Composer Studio™ software to program the DM642;
all relevant DM642 control registers can be accessed and controlled through a generic 1°C address.

In addition to the command file provided with this EVM, additional command files to be used with TI's EVM
control software (WinVCC) can be provided from Tl to support easy programming of the TVP5154 and
DM642 registers to show the most common scaling configurations for both NTSC and PAL formats. When
using these command files or when setting the register values through a standard 1°C bus interface, it is
important to enable and program the 5154 outputs before configuring the DM642 registers. The DM642
portion of the TVP5154EVM consists only of the DM642, SDRAM, and flash memory.
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9.2

9.2.1

Details of the DM642 Code and Control Registers
Details of the DM642 code and control registers are:

The DM642 device address is 0x40h by default. The DM642 is setup as an 1°C slave.

The DM642 executes code on power up from the flash using the PClI GPIO to control the address
MSB.

Virtual I°C registers are created within the DM642 in order to control the capture and display of the
scaled/unscaled data from the TVP5154 video decoder. These registers are described in [able 9.

The virtual 1°C registers support scaled and unscaled video outputs independently for each of the four
video decoders, with the option to overlay scaled video onto unscaled video, and to define the
quadrant location of each scaled channel.

The virtual 1C registers provide easy control/access to the GPIOs currently tied to LEDs. Please refer
to the TVP5154EVM schematics for options to associate an LED on/off with a register setting.

The DM642 is not responsible for any scaling. All video scaling is performed by the TVP5154. The
DM642 is only responsible for image capture and display.

The DM642 virtual registers can be controlled by using the DM642 Control Window or through the
Generic I°C registers.

DM642 Control Window

The DM642 settings can be easily controlled by using the DM642 Control window. This window represents
the DM642 register data in a user-friendly format. The data is organized for each of the four decoders (see
Figure 21)).

To open this, click on DM642 Control in the Tools menu.

DM642 Control

Decoder 1 Decoder 2

Image Capture » Image Capture .
Image Position Image Poszition

Dizabled % Quadl © Quad? (it " Quadl & Quad 2

Widea Standard " Quad3 " Quadd Widen Standard  Quad? ¢ Quad4
PaL - PaL -

Image Size Apply Image Size Apply
|S|F [352324D]j Click to Program Yideo SIF - [3R2w240) « Click. to Program Video

Standard and Image Size Standard and Image Size

Decoder 3 Decoder 4
| Capt | Capt
mage Lapture Image Position fage Lapture Image Position

QDIS&HECI " Quadl " Quad2 Dlsab4||8d " Quad1 " Quad2

ideo Standard * Quad3  Quad4 Yideo Standard " Quad3 & Quadd
PaL - PAL -

Image Size Apply Image Size Apply
Click ta Program Yideo ’—_| Click to Program Yideo
SIF [352:240) ¥ Standard and Image Size SIF - [352:240) > Standard and Image Size

Flash Major Flash Minar LED Cantral

o 1w F1r2ralr4rsrery Clase

Figure 21. DM642 Control Window
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When the DM642 Control window is opened, all readable registers for the device are read from software
to initialize the dialog page. Register details are given in [able §. Values on the page are changed by
manipulating the various dialog controls as described in Table §. The data is organized for each of the
four decoders, allowing independent control of each decoder.

Table 8. DM642 Control Window Controls

CONTROL DEFINITION
Read All Reads all defined readable registers from the device and updates the register window.
Causes all changes made to the page since the last Apply to be discarded. Changes made to dialog controls
with ‘immediate register update’ are not discarded, since they have already been changed in the DM642
Close registers.

Does not write to registers.
Closes the dialog.

Image Capture

Enables image capture in the DM642 for that given decoder (1-4). Immediate register update.

Video Standard

Used to inform the DM642 of the input color standard for that given decoder (1-4). No change in register until
Apply is clicked.
Does not change the video standard setting for the TVP5154.

Image Size

Used to inform the DM642 of the input image size for that given decoder (1-4). No change in register until Apply
is clicked.
Actual scaling is done in the TVP5154.

Image Position

Defines the quadrant location for the input of that given decoder (1-4). Immediate register update.

Immediately changes DM642 registers for input image size and input color standard for that given decoder
(1-4).

Apply Enables TVP5154 scaler and programs correct scaling register settings into TVP5154 based on selected input
standard and image size for that given decoder (1-4).

Flash . . o . .

Major/Minor Reads the data from the Flash Version registers and writes it into the register window.

LED Control Changes LED (1-7) status. Checked: LED is ON. Unchecked: LED is OFF. Immediate register update.

9.2.2 DM642 Virtual 1°C Register Map

Table 9. DM642 Virtual 1°C Register Map

REGISTER DESCRIPTION ADDRESS DATA (DEFAULT)
Decoder 1 Register 00h 02h
Decoder 2 Register 01h 12h
Decoder 3 Register 02h 22h
Decoder 4 Register 03h 32h
Decoder 1 Input Format Register 04h 01h
Decoder 2 Input Format Register 05h 01h
Decoder 3 Input Format Register 06h 01h
Decoder 4 Input Format Register 07h 01h
LED Control 08h 00h
Flash Version: Major 09h 01h
Flash Version: Minor 0Ah 00h
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9.2.3 DM642 Virtual 1°C Register Details
Table 10. Decoder 1 Register
Address 00h
Default 02h
7 6 5 | 4 3 2 1 0
Reserved Position (é?]rgglr; Capture Size

Capture Size

Bit 2 Bit 1 Bit 0

Unscaled 0 0 0

QSIF - 176 x 120 0 0 1

SIF — 352 x 240 (1/4 NTSC) 0 1 0

(default)

QCIF — 176 x 144 0 1 1

CIF — 352 x 288 (1/4 PAL) 1 0 0

QVGA - 320 x 240 1 0 1

VGA - 640 x 480 1 1 0

Reserved 1 1 1

Capture Enable Bit 3

Disable (default) 0

Enable 1

Position Bit 5 Bit 4

Quadrant 1 (default) 0 0 Quad 1 | Quad 2
Quadrant 2 0 1

Quadrant 3 1 0 ouad 3 | Quad 4
Quadrant 4 1 1

Scaled capture sizes always take priority over unscaled capture sizes.

Decoder priorities are always such that Decoder 1 is the highest priority, Decoder 2 is the second highest,

etc.
For example, if Decoders 1 and 4 are scaled to 1/4 size and Decoders 2 and 3 are unscaled, this display
results:

Decoder 1| Decoder 2

Scaled Unscaled
Decoder 2 | Decoder 4
Unscaled Scaled
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Note: The unscaled Decoder 2 displays in both Quadrant 2 and 3 since Decoder 2 takes priority
over Decoder 3 when both are unscaled.
Table 11. Decoder 2 Register
Address 01h
Default 12h
7 6 | 3 1 0
Reserved Position Cé?gg;: Capture Size
Capture Size Bit 2 Bit 1 Bit 0
Unscaled 0 0 0
QSIF -176 x 120 0 0 1
SIF — 352 x 240 (1/4 NTSC) 0 1 0
(default)
QCIF — 176 x 144 0 1 1
CIF — 352 x 288 (1/4 PAL) 1 0 0
QVGA — 320 x 240 1 0 1
VGA — 640 x 480 1 1 0
Reserved 1 1 1
Capture Enable Bit 3
Disable (default) 0
Enable 1
Position Bit 5 Bit 4
Quadrant 1 0 0 Quad 1 | Quad 2
Quadrant 2 (default) 0 1
Quadrant 3 1 0
Quad 3 | Quad 4
Quadrant 4 1 1
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Table 12. Decoder 3 Register
Address 01h
Default 22h
7 6 | 3 2 1 0
Reserved Position CE{;F;[;JI? Capture Size
Capture Size Bit 2 Bit 1 Bit 0
Unscaled 0 0 0
QSIF - 176 x 120 0 0 1
SIF — 352 x 240 (1/4 NTSC) 0 1 0
(default)
QCIF — 176 x 144 0 1 1
CIF — 352 x 288 (1/4 PAL) 1 0 0
QVGA - 320 x 240 1 0 1
VGA — 640 x 480 1 1 0
Reserved 1 1 1
Capture Enable Bit 3
Disable (default) 0
Enable 1
Position Bit 5 Bit 4
Quadrant 1 0 0 Quad 1 | Quad 2
Quadrant 2 0 1
Quadrant 3 (default) 1 0 ouad 3 | Quad 4
Quadrant 4 1 1
Table 13. Decoder 4 Register
Address 01h
Default 32h
7 6 3 2 1 0
Reserved Position cé?ggl': Capture Size
Capture Size Bit 2 Bit 1 Bit 0
Unscaled 0 0 0
QSIF - 176 x 120 0 0 1
SIF — 352 x 240 (1/4 NTSC) 0 1 0
(default)
QCIF — 176 x 144 0 1 1
CIF — 352 x 288 (1/4 PAL) 1 0 0
QVGA - 320 x 240 1 0 1
VGA — 640 x 480 1 1 0
Reserved 1 1 1
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Capture Enable Bit 3
Disable (default) 0
Enable 1
Position Bit 5 Bit 4
Quadrant 1 0 0 Quad 1 | Quad 2
Quadrant 2 0 1
Quadrant 3 1 0
Quad 3 | Quad 4
Quadrant 4 (default) 1 1
Table 14. Decoder 1 Input Format Register
Address 04h
Default 01lh
7 6 | 5 ] 4 | 3 2 1 0
Reserved Input Color Standard

Input Color Standard

NTSC

(B, D, G, H, I, N) PAL
(default)

Reserved

Bit 2 Bit 1 Bit 0
0 0 0
0 0 1

The Input Color Standard register is used to inform the DM642 of the input color standard for that given
decoder (1-4). The output format of the DM642 is set to the standard with the largest majority based on
Registers 04h—07h. If the number of input color standards is equal, the DM642 automatically default to

PAL output.
Table 15. Decoder 2 Input Format Register
Address 05h
Default 01lh
7 6 | 5 ] 4 | 3 2 1 0
Reserved Input Color Standard

Input Color Standard

NTSC

(B, D, G, H, I, N) PAL
(default)

Reserved

Bit 2 Bit 1 Bit 0
0 0 0
0 0 1
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Table 16. Decoder 3 Input Format Register
Address 06h
Default 01h
7 6 | 5 | 4 | 3 2 1 0
Reserved Input Color Standard
Input Color Standard Bit 2 Bit 1 Bit 0
NTSC 0 0 0
(B, D, G, H, I, N) PAL
(default) 0 0 1
Reserved
Table 17. Decoder 4 Input Format Register
Address 07h
Default 01h
7 6 | 5 | 4 | 3 2 1 0
Reserved Input Color Standard
Input Color Standard Bit 2 Bit 1 Bit 0
NTSC 0 0 0
(B, D, G, H, I, N) PAL
(default) 0 0 1
Reserved
Table 18. LED Control Register
Address 08h
Default 00h
7 6 5 4 3 2 1 0
Reserved LED 7 Status | LED 6 Status | LED 5 Status | LED 4 Status | LED 3 Status | LED 2 Status | LED 1 Status

LED (1-7) Status

=0 (LED off)
=1 (LED on)
Table 19. Flash Major Version Register
Address 09h
Default 01lh
7 6 | 5 ] 4 | 3 ] 2 1 0
Flash Major Version
Table 20. Flash Minor Version Register
Address 0Ah
Default 00h
7 6 5 4 3 | 2 1 0
Flash Minor Version
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10

10.1

Troubleshooting

This chapter discusses ways to troubleshoot the TVP5154EVM.

Troubleshooting Guide

If you are experiencing problems with the TVP5154EVM hardware or the WinVCC software, see

for available solutions.

Table 21. TVP5154EVM Troubleshooting

SYMPTOM

CAUSE

SOLUTION

At startup, the error message Cannot find
DLL file DLPORTIO.DLL appears.

The parallel port driver supplied with the
EVM has not been installed.

Run Port95NT.EXE on the CD to install
the driver.

Blank screen

Wrong video input is selected.

Go to Edit— Property Sheets - TVP5154,
Analog Video page, select the correct
video input(s) and click Apply.

(The composite video input 1 is selected
by default.)

Source is connected to the wrong input
connector.

Connect source to the correct input
connector.

YCbCr outputs or clock output is disabled.

Go to Edit- Property Sheets - TVP5154,
Output Control page, check the enable
YCbCr outputs and enable clock outputs
check boxes and click Apply.

No color

Wrong mode is selected for color
subcarrier genlock output.

Go to Edit— Property Sheets - TVP5154,
Synchronization page, set the Fsc control
format to RTC and click Apply.

GLCO pin is not set to output the GLCO
signal.

Go to Edit- Property Sheets - TVP5154,
Output Control page, set the drop down
box labeled FID/GLCO (pin 23) to genlock
output (GLCO) and click Apply.

Screen colors are only magenta and
green.

Wrong YCbCr output format

Go to Edit- Property Sheets - TVP5154,
Output Control page, set the YCbCr
output format to 8-bit 4:2:2 YCbCr
w/ITU-R BT.656 embedded sync mode
and click Apply.

Video standard auto-switch does not work
on the video decoder side.

Auto-switch masks are not set correctly.

Go to Edit- Property Sheets - TVP5154,
Mode Selection page, uncheck all
standards to be included in auto-switch
processing and click Apply.

Video decoder is not in auto-switch mode.

Go to Edit— Property Sheets - TVP5154,
Mode Selection page, set the drop-down
box to multistandard and click Apply.

Video standard auto-switch does not work
on the video encoder side.

Auto-switch polling is not enabled.

Click real-time polling in the Tools menu.
Click Enable All and OK. This should be
disabled if using a composite output.
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Table 21. TVP5154EVM Troubleshooting (continued)

SYMPTOM

CAUSE

SOLUTION

No 12C communication

Decoder I12C slave address is wrong.

Make sure 12C slave address jumpers on
the TVP5154 decoder module are across
pins 2 and 3.

Encoder I2C slave address is wrong.

Slave address is hard coded to be 0x54 in
the command file. Make sure the 12C slave
address jumper on encoder module is
across pins 2 and 3.

Parallel cable is not connected from PC
parallel port to the TVP5154 decoder
module DB25 connector.

Connect cable

EVM is not powered on.

Power supply must be plugged into a
100-V to 240-V/47-Hz to 63-Hz power
source, and the cord must be plugged into
the power connector on the EVM.

Wrong type of parallel cable.

Some parallel cables are not wired
straight through pin for pin. Use the cable
supplied with the EVM.

Device was placed in power-down mode.

Press the Reset button on the TVP5154
Decoder Module.

EVM was configured for an external 12C
master.

Reinstall 0-Q resistors R5 and R6. Control
EVM using the PC parallel port.

PC parallel port mode is not set correctly.

DO THIS AS A LAST RESORT. Reboot
PC, enter BIOS setup program, and set
parallel port LPT1 mode (Addr 378h) to
ECP mode or bidirectional mode
(sometimes called PS/2 mode or byte
mode). If already set to one of these two
modes, switch to the other setting (see

Beclion T0.9).

Still no 12C communication

PC may not be capable of operating in the
required parallel port mode. This is true of
some laptop computers. Use a different
computer, preferably a desktop PC.

When WinVCC is started and the WinVCC Configuration dialog box is closed with OK, the I°C system test
is performed (unless the 1°2C System Test program options button was disabled).

If the 1°C system test fails, a dialog box (see appears. This example reports that a read from
TVP5154 failed, using slave address 0xB8, sub-address OxDO. The data read was 0x78. The expected

data was 0x00.

After noting which device had a problem, click OK to continue. Next, the Corrective Action Dialog box

appears to fix the problem.
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12C Test Report

T+P5154. FAILED - Read, Dew=0«B8, Addi=0xD0, Data=0=78 - Mizcompare [wrote 0x00)

7311 Encoder Module. . HOT TESTED

Figure 22. I°C System Failure Dialog Box

10.2 Corrective Action Dialogs
After closing the I°C system test report dialog box, a dialog box (see appears.

! "_\ 15 a parallel cable connecked Fram the computer's LPT1 part to the evaluation module (EYM) and power applied to the EYM ?
L

Yes Mo

Figure 23. Corrective Action Dialog Box

1. If the parallel port cable is NOT connected between to PC and the TVP5154EVM, or if the EVM power

is not on:
a. Click NO.
b. The dialog box shown in appears instructing you to correct the problem.
c. Correct the problem.
d. Click OK to continue. The Real-Time Polling dialog appears.
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10.2.1

! E Connect a parallel cable from the computer's LPT1 port to the EYM and apply power bo the EXM, Then, click Ok,

Figure 24. Corrective Action Required

If the cable is connected from the PC parallel port to the TVP5154EVM and the EVM power is on:

a. Click Yes.
b. The dialog box shown in appears. This dialog box appears if the PC parallel
port mode setting may need to be changed.

Note: Only run the PC BIOS setup program if the I1°C communication problem cannot be
resolved in another way (correct slave address settings, reset or power cycle the
EVM, and/or check that the device type selected was TVP5154).

c. Click OK to continue.
d. The real-time polling dialog appears. Click OK to close it and get to the main menu.
e. Click Exit in the File menu to exit the program.
f. See the troubleshooting guide in [Table 21].
WinVCC4 X

CAMMOT BE RESOLVED IR AMOTHER \WAY (Correct device bype andfor slave address settings, reset or power cycle
the EYM.), restart this computer and enter the BICS setup program. Change the LPT1 parallel port { base address:
0378 ) ko ECP mode or to BI-DIRECTIONAL mode (also called P52 mode or BYTE mode). IF one of these bwo modes
iz already selected, change ko the opposite mode.

'f This pragranm MaY MOT waork with the current parallel port mode setting in BIOS. IF the I2C communication prablem
L]

The Following parallel port modes were Found to be Functional: ECP:Bidirectional + SPP + BI-DIRECTIOMAL.

Figure 25. Corrective Action Required

Setting the PC Parallel Port Mode

Note: Only run the PC BIOS setup program if the 1°C communication problem cannot be
resolved in another way (correct slave address settings, reset or power cycle the EVM,
and/or check that the device type selected was TVP5154).

Restart the PC.
During the boot process, enter the BIOS setup program by pressing the required key (usually the initial

text screen indicates which key to press).

Find the place where the parallel port settings are made.

. Set the parallel port LPT1 at address 378h to ECP mode or bidirectional mode (sometimes called PS/2

mode or byte mode). If one of these two modes is already selected, change to the opposite mode.
Exit and save changes.
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TVP5154EVM Schematics

10.2.2  General I°C Error Report

The I2C Error Report shown in appears when an 12C error occurs at any time other than after
the I12C system test. In this example, there is acknowledge error at slave address 0x54 (the video encoder
module). The error occurred on Read Cycle Phase 1 on the device (slave) address byte.

I12C Error Report

Read, Dewv=0x54, Addr=000, Data=0:00 - MO ACKN: RD1-DEY

[ Ignore |2C Acknowledge Ermars Exit Program
Figure 26. I°C Error
11  TVP5154EVM Schematics
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IMPORTANT NOTICE

Texas Instruments Incorporated and its subsidiaries (TI) reserve the right to make corrections, modifications,
enhancements, improvements, and other changes to its products and services at any time and to discontinue
any product or service without notice. Customers should obtain the latest relevant information before placing
orders and should verify that such information is current and complete. All products are sold subject to TI's terms
and conditions of sale supplied at the time of order acknowledgment.

Tl warrants performance of its hardware products to the specifications applicable at the time of sale in
accordance with TI's standard warranty. Testing and other quality control techniques are used to the extent Tl
deems necessary to support this warranty. Except where mandated by government requirements, testing of all
parameters of each product is not necessarily performed.

TI assumes no liability for applications assistance or customer product design. Customers are responsible for
their products and applications using TI components. To minimize the risks associated with customer products
and applications, customers should provide adequate design and operating safeguards.

TI does not warrant or represent that any license, either express or implied, is granted under any Tl patent right,
copyright, mask work right, or other Tl intellectual property right relating to any combination, machine, or process
in which TI products or services are used. Information published by Tl regarding third-party products or services
does not constitute a license from Tl to use such products or services or a warranty or endorsement thereof.
Use of such information may require a license from a third party under the patents or other intellectual property
of the third party, or a license from Tl under the patents or other intellectual property of TI.

Reproduction of information in Tl data books or data sheets is permissible only if reproduction is without
alteration and is accompanied by all associated warranties, conditions, limitations, and notices. Reproduction
of this information with alteration is an unfair and deceptive business practice. Tl is not responsible or liable for
such altered documentation.

Resale of Tl products or services with statements different from or beyond the parameters stated by TI for that
product or service voids all express and any implied warranties for the associated TI product or service and
is an unfair and deceptive business practice. Tl is not responsible or liable for any such statements.

Following are URLs where you can obtain information on other Texas Instruments products and application
solutions:

Products Applications

Amplifiers amplifier.ti.com Audio www.ti.com/audio

Data Converters dataconverter.ti.com Automotive www.ti.com/automotive

DSP dsp.ti.com Broadband www.ti.com/broadband

Interface interface.ti.com Digital Control www.ti.com/digitalcontrol

Logic logic.ti.com Military www.ti.com/military

Power Mgmt power.ti.com Optical Networking www.ti.com/opticalnetwork

Microcontrollers microcontroller.ti.com Security www.ti.com/security

Low Power Wireless www.ti.com/lpw Telephony www.ti.com/telephony
Video & Imaging www.ti.com/video
Wireless www.ti.com/wireless

Mailing Address: Texas Instruments
Post Office Box 655303 Dallas, Texas 75265
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